
ΕΝΟΤΗΤΑ 2η – Transformations και Selections

Έχοντας λοιπόν ξεκινήσει να αντιλαμβανόμαστε τον τρόπο με τον οποίο λειτουργεί το Photoshop, 
στην ενότητα αυτή θα διδαχθούμε κάποιες βασικές λειτουργίες του προγράμματος όπως την 
μεταφορά αντικειμένων, την αλλαγή του σχήματος τους μέσω της εντολής Free Transform καθώς 
και τον τρόπο με τον οποίο μπορούμε να χρησιμοποιήσουμε τα Selection tools. 

2.1 Move Tool 

Πριν όμως αρχίσουμε την ανάλυση των παραπάνω θα πούμε μερικά λόγια για το Move tool.
Το Move tool είναι ένα από τα πιο απλά εργαλεία που θα συναντήσουμε στην εργαλειοθήκη μας. Η 
βασική του λειτουργία, αν και αυτονόητη λόγω του ονόματος του, είναι η μεταφορά των διαφόρων 
αντικειμένων της σύνθεσης μέσα στον χώρο εργασίας μας. 

Η συντόμευση του Move Tool είναι το πλήκτρο V. Έχοντας λοιπόν ενεργό το παράθυρο του 
προγράμματος, απλά πατάμε στο πληκτρολόγιο V και όποιο εργαλείο και να είχαμε επιλεγμένο 
προηγουμένως, την θέση του έχει πάρει το Move Tool.

Η μετακίνηση στοιχείων στην σύνθεση μας είναι πολύ απλή μέσω δύο διαφορετικών μεθόδων τις 
οποίες θα εξηγήσουμε στην συνέχεια.

Για να κατανοήσουμε όμως καλύτερα την λειτουργία των παραπάνω μεθόδων, θα δημιουργήσουμε 
ένα αρχείο το οποίο θα χρησιμοποιήσουμε ως παράδειγμα για την επεξήγηση των μεθόδων μας.

Καταρχήν δημιουργούμε ένα νέο αρχείο επιλέγοντας  από το κεντρικό μενού File > New και 
συμπληρώνοντας στα αντίστοιχα πεδία τις παρακάτω ρυθμίσεις.

Έχοντας δημιουργήσει το νέο αρχείο, επιλέγουμε το Rectangle Tool από τo Tools Panel. Στην 
συνέχεια σύρουμε το ποντίκι πάνω στην επιφάνεια εργασίας και απελευθερώνουμε όταν έχουμε 
δημιουργήσει το μέγεθος που επιθυμούμε. Το νέο αυτό σχήμα θα δημιουργηθεί σε ένα νέο Layer 
όπως παρατηρούμε μέσω του Layers Panel.

Σημείωση:
Σε περίπτωση που θέλουμε να δημιουργήσουμε τετράγωνο σχήμα μπορούμε να κρατήσουμε πατημένο 
το πλήκτρο Shift ενώ σύρουμε. Κρατώντας πατημένο το Shift ¨αναγκάζουμε¨ το εργαλείο μας να 
δημιουργήσει ένα τέλειο τετράγωνο.



Τώρα που έχουμε δημιουργήσει ένα βασικό σχήμα στον καμβά μας μπορούμε να το 
χρησιμοποιήσουμε για να εξηγήσουμε τις μεθόδους μετακίνησης που αναφέραμε προηγουμένως. 

Σύροντας με το ποντίκι

Καταρχήν, μέσω του Layers Panel, είναι απαραίτητο να σιγουρευτούμε ότι έχουμε επιλεγμένο το  
thumbnail του Layer στο οποίο βρίσκεται το τετράγωνο μας.

Στην συνέχεια, επιλέγοντας το Move Tool και σύροντας, μπορούμε να μετακινήσουμε το 
τετράγωνο που βρίσκεται στην επιφάνεια εργασίας σε όποια θέση του καμβά που επιθυμούμε.

Μετακίνηση χρησιμοποιώντας τα βέλη του πληκτρολογίου

Επιλέγοντας ξανά το Move Tool και έχοντας πάντα επιλεγμένο το Layer που περιέχει το 
αντικείμενο μας, μπορούμε να το μετακινήσουμε, πατώντας τα βέλη κατεύθυνσης. Βέβαια, η 
μέθοδος αυτή ενδείκνυται περισσότερο για την μετακίνηση ενός αντικειμένου σε μικρές 
αποστάσεις λόγω του ότι μετακινεί ένα pixel ανά πάτημα του πλήκτρου.

Αν επιθυμούμε να μετακινήσουμε το αντικείμενό μας ανά 10 pixel μπορούμε να κρατήσουμε 
πατημένο το πλήκτρο Shift παράλληλα με το πάτημα του βέλους κατεύθυνσης. 

2.2 Εντολή Free Transform

Η εντολή Free transform μας δίνει την δυνατότητα μεταβολής του σχήματος ενός αντικειμένου και 
εντοπίζεται στο κεντρικό μενού  Edit > Free Transform ή Free Transform Path, αναλόγως του τι 
έχουμε επιλεγμένο. Αν και πολύ απλή στην χρήση της, η εντολή αυτή πολύ να προκαλέσει σύγχυση 
σε περίπτωση που δεν διδαχθούμε σωστά την χρησιμότητα της. 

Με την βοήθεια του τετραγώνου που δημιουργήσαμε στο παραπάνω παράδειγμα θα δούμε τις 
μεταβολές που μπορούμε να προκαλέσουμε στο σχήμα του.

Επιλέγουμε λοιπόν από το κεντρικό μενού Edit > Free Transform Path που είναι η επίσημη 
εντολή για τις λειτουργίες που θα εκτελέσουμε. Θα δούμε στο αντικείμενο μας να εμφανίζονται 
Handles (λαβές) που θα μας επιτρέψουν την μετατροπή του σχήματος.



Βέβαια, ένας πιο εύκολος αλλά ανεπίσημος τρόπος, είναι απλά να επιλέξουμε το Layer στο οποίο 
βρίσκεται το αντικείμενο μας και έπειτα να επιλέξουμε το Move tool. Στην συνέχεια, από την 
Options Bar που τώρα αναφέρεται σε ρυθμίσεις του εργαλείου που μόλις επιλέξαμε, μπορούμε να 
τσεκάρουμε την επιλογή Show Transform Controls. Με τον τρόπο αυτό εμφανίζουμε επίσης τα 
Transformation handles (¨λαβές¨).

Αυτή την κίνηση θα χρειαστεί να την κάνουμε μόνο μια φορά, μιας και την επόμενη φορά που θα 
επιλέξουμε το Layer ενός αντικειμένου και έπειτα το Move tool, θα μπορούμε να δούμε απευθείας 
τις ¨λαβές¨ . Με τον τρόπο αυτό και με την βοήθεια συντομεύσεων του πληκτρολογίου, μπορούμε 
να εφαρμόσουμε όχι όλα αλλά τα περισσότερα transformations πάνω στο αντικείμενό μας. 

2.2.1 Scale (αυξομείωση μεγέθους)

Επιλέγουμε το Move tool ή Edit > Free Transform Path και τοποθετούμε το ποντίκι πάνω από 
ένα από τα Handles που έχουν εμφανιστεί. Για παράδειγμα στην πάνω και δεξιά γωνία του 
τετραγώνου. Θα παρατηρήσουμε ότι το ποντίκι θα αλλάξει μορφή και θα δούμε κάτι σαν αυτό που 
φαίνεται στην παρακάτω εικόνα.

Μπορούμε να κάνουμε κλικ και να σύρουμε το handle και θα δούμε το μέγεθος του σχήματος να 
μεταβάλλεται. Κρατώντας πατημένο το πλήκτρο Shift ενώ σύρουμε μπορούμε να διατηρήσουμε το 
aspect ratio του σχήματος.

Η έννοια aspect ratio ενός σχήματος περιγράφει την αναλογική σχέση μεταξύ του 
πλάτους του και το ύψος του.



2.2.2 Rotate (περιστροφή)

Επιλέγουμε το Move tool ή τοποθετούμε το ποντίκι πάνω από τα γωνιακά Handles του 
αντικειμένου. Μπορούμε να δούμε ξανά ότι η η μορφή του κέρσορα αλλάζει. Αυτή την φορά το 
σύμβολο που θα δούμε, και αντιπροσωπεύει την περιστροφή του σχήματος, είναι το παρακάτω.

Στο σημείο αυτό κάνουμε κλικ και σύρουμε το σχήμα μας προς την κατεύθυνση που θέλουμε να 
περιστραφεί.

2.2.3 Skew (δίνουμε κλίση στο αντικείμενο μας)

Επιλέγοντας από το κεντρικό μενού την επιλογή Edit > Transform  > Skew έχουμε την 
δυνατότητα να δώσουμε κλίση στο σχήμα μας. 
Για να δώσουμε κλίση, σύρουμε μια από τις πλευρικές λαβές του σχήματός μας.

Φυσικά μπορούμε να επιλέξουμε και σε αυτή την περίπτωση το Move tool. Κρατώντας πατημένο 
το πλήκτρο Ctrl + Alt για Windows και Cmd + Alt για Mac μπορούμε να σύρουμε ξανά κάποια 
από τις πλευρικές λαβές και να πετύχουμε την μετατροπή που επιθυμούμε. 



2.2.4 Distort (παραμόρφωση)

Επιλέγοντας από το κεντρικό μενού την επιλογή Edit > Transform > Distort μπορούμε να 
παραμορφώσουμε (distort) το σχήμα. Απλά σύρουμε όποια από τις γωνιακές λαβές επιθυμούμε για 
να προκαλέσουμε την παραμόρφωση που επιθυμούμε.

2.2.5 Perspective (προοπτική)

Για να δώσουμε προοπτική στο σχήμα μας επιλέγουμε από το κεντρικό μενού 
Edit > Transform > Perspective.

Στην συνέχεια, απλά σύρουμε όποια από τις γωνιακές λαβές επιθυμούμε για να 
πραγματοποιήσουμε την αλλαγή.



2.2.6 Warp 

Για την επιλογή Warp επιλέγουμε από το κεντρικό μενού Edit > Transform > Warp.
Το εργαλείο αυτό έχει κάποιες μικρές διαφοροποιήσεις στην χρήση του σε σχέση πάντα με τις 
υπόλοιπες επιλογές transformations.

Καταρχήν θα δούμε ότι με την επιλογή Warp ένα grid (πλέγμα) θα προστεθεί πάνω από το σχήμα 
μας. Αυτό το grid μας δίνει την δυνατότητα μεταβολής του σχήματός μέσω κάποιων σημείων 
ελέγχου ή ακόμη και γραμμών του.

Να τονίσουμε ότι υπάρχει μια σειρά έτοιμων επιλογών από τις οποίες μπορούμε να επιλέξουμε. Οι 
επιλογές αυτές είναι διαθέσιμες από το αναδυόμενο μενού Warp που μπορούμε να εντοπίσουμε 
στην Options bar.

Στην παραπάνω εικόνα μπορούμε να δούμε όλες τις διαθέσιμες μεταβολές για την επιλογή Warp 



Ενδεικτικά αναφέρω ότι επιλέγοντας μια από τις διαθέσιμες ρυθμίσεις Warp, και συγκεκριμένα 
αυτή της Arc Lower, το τετράγωνό μας διαμορφώνεται όπως το παρακάτω σχήμα.

Σημείωση:
Σε περίπτωση που προκαλούμε μετατροπές σε ένα Path τότε το μενού με τίτλο Transform 
μετονομάζεται σε Transform Path.  

2.3 Selections 
Στο σημείο αυτό θα δείξουμε τον τρόπο με τον οποίο μπορούμε να δημιουργούμε Selections και 
Layer masks. Οι γνώσεις που θα διδαχθούμε θα αποδειχθούν πολύτιμες για τις επόμενες ενότητες, 
μιας και θα δούμε ότι είναι απαραίτητη η κατανόηση τους για την σωστή χρήση του προγράμματος 
και την πλήρη εκμετάλλευση των δυνατοτήτων του.

Τι εννοούμε με τον όρο Selection

Καταρχήν λοιπόν πρέπει να κατανοήσουμε τι ακριβώς εννοούμε με τον όρο Selection. 
Selection ονομάζουμε την διαδικασία κατά την οποία επιλέγουμε ένα μέρος ή το σύνολο των pixels 
της σύνθεσής μας.  

Θα δούμε ότι κάνοντας ένα Selection, δηλαδή όταν επιλέγουμε ένα τμήμα ενός Layer, μπορούμε 
να πραγματοποιήσουμε αλλαγές καθώς και να επεξεργαστούμε μόνο το συγκεκριμένο τμήμα της 
επιλογής αυτής. Έτσι το τμήμα του Layer που δεν έχει επιλεγεί, παραμένει προστατευμένο λόγω 
του ότι οποιαδήποτε αλλαγή επιθυμούμε να εφαρμόσουμε θα περιοριστεί αποκλειστικά εντός του 



Selection που έχουμε δημιουργήσει.

Τέλος, δημιουργώντας μια Layer mask έχουμε την δυνατότητα να αποκρύψουμε είτε να 
εμφανίσουμε τμήματα ενός Layer. Θα δούμε αναλυτικά στην συνέχεια πως γίνεται αυτό.

Τι είναι τα Soft & Hard Edges

Πριν όμως αναλύσουμε τις μεθόδους με τις οποίες μπορούμε να δημιουργήσουμε ένα Selection, θα 
δώσουμε ένα παράδειγμα, μέσω της παρακάτω εικόνας, για τις έννοιες Soft & Hard Edges 
(σκληρών και μαλακών άκρων). 

Λόγω της αναφοράς των εννοιών αυτών στις παρακάτω μεθόδους, βλέπουμε στην εικόνα την 
μεταξύ τους διαφορά έχοντας χρησιμοποιήσει το Brush tool. φυσικά η λογική είναι η ίδια και για 
την περίπτωση που αναφερόμαστε σε εικόνα με Soft ή Hard Edges και όχι απλά σε ένα σχήμα..

2.4 Marquee Tools.

Τα Marquee tools αποτελούνται από ένα σύνολο εργαλείων επιλογής (selection tools) τα οποία 
είναι τα εξής: το Rectangular Marquee tool, το Elliptical Marquee tool, το Single Row 
Marquee tool και το Single Column Marquee tool. 

Τα παραπάνω, αποτελούν μερικά από τα πιο βασικά Selection tools του προγράμματος και η 
συντόμευση του πληκτρολογίου για τα εργαλεία αυτά είναι το πλήκτρο Μ.

Υπενθυμίζω ότι υπάρχουν εικονίδια τα οποία περιέχουν πάνω από ένα εργαλείο και φέρουν ένα 
βέλος στο κάτω δεξιά τμήμα τους. Ένα από αυτά τα εικονίδια είναι και αυτό που περιέχει τα 
Marquee tools. Έχουμε λοιπόν πρόσβαση στο καθένα από αυτά τα εργαλεία κάνοντας 
παρατεταμένο κλικ στο αρχικό εικονίδιο.



 

                                        
Marquee Tools

2.4.1 Rectangular Marquee Tool  
Το Rectangular Marquee tool μας δίνει την δυνατότητα να κάνουμε selections σε σχήμα 
παραλληλογράμμων και τετραγώνων. Επιλέγοντας το Layer στο οποίο θέλουμε να κάνουμε το 
Selection και έπειτα επιλέγοντας το Rectangular marquee tool, απλά κάνουμε κλικ και σύρουμε 
στην επιφάνεια εργασίας μας. 

Κρατώντας πατημένο το πλήκτρο Shift ενώ σύρουμε, μπορούμε να δημιουργήσουμε ένα selection 
σε σχήμα τέλειου τετραγώνου.

Κρατώντας πατημένο το πλήκτρο Alt ενώ σύρουμε, μπορούμε να κάνουμε ένα selection το οποίο 
να έχει σαν σημείο αναφοράς το κέντρο του σχήματος.

Σε περίπτωση που επιθυμούμε να μετακινήσουμε το Selection ταυτόχρονα με τον χρόνο 
σχηματισμού του, τότε κρατάμε πατημένο το πλήκτρο Space και μετακινούμε το σχήμα μας. Όταν 
έχουμε φέρει το σχήμα στην θέση που επιθυμούμε, τότε απελευθερώνουμε το Space. 

2.4.2 Elliptical Tool 

Το Elliptical Marquee tool μας δίνει την δυνατότητα δημιουργίας ενός Selection σε σχήμα έλλειψης 
και κύκλου. Όπως και για το Rectangular marquee tool έτσι και εδώ, μπορούμε να 
χρησιμοποιήσουμε τα πλήκτρα Shift, Alt και Space για την επεξεργασία του σχήματος.

2.4.3 Single Row & Single Column Tools   

Με τα εργαλεία Single Row Marquee και Single Column Marquee μπορούμε να δημιουργούμε 
Selections μιας γραμμής εικονοστοιχείων (single row of pixels) ή μιας στήλης εικονοστοιχείων 
(single column of pixels) αντίστοιχα. Το μόνο που έχουμε να κάνουμε είναι να κάνουμε κλικ στο 
σημείο της εικόνας που επιθυμούμε και αυτόματα θα δημιουργηθεί το αντίστοιχο Selection κατά 
μήκος της σύνθεσής μας. Τα δύο αυτά εργαλεία δεν είναι τα πλέον δημοφιλή και πιθανόν να μην τα 
χρησιμοποιήσετε όντας αρχάριοι. Όμως καλό θα ήταν να τα έχουμε υπόψιν μας σε περίπτωση που 
υπάρχει η ανάγκη δημιουργίας Single pixel selections.

Όπως αναφέραμε η συντόμευση για τα Marquee Tool είναι το πλήκτρο Μ. Πατώντας λοιπόν το 



πλήκτρο Μ θα επιλεγεί το Rectangular marquee tool ή το Elliptical marquee tool ανάλογα του πιο 
είχαμε χρησιμοποιήσει με το τελευταίο άνοιγμα του προγράμματος. Σε περίπτωση όμως που 
επιθυμούμε επιπλέον πλοήγηση μεταξύ των δύο αυτών εργαλείων μπορούμε να κάνουμε χρήση της 
συντόμευσης Shift + M η οποία μας επιτρέπει την γρήγορη εναλλαγή μεταξύ του Rectangular 
marquee και του Elliptical marquee.

Επιπλέον ρυθμίσεις

Όταν χρησιμοποιούμε τα Marquee tools θα δούμε στην Option bar να εμφανίζονται οι επιμέρους 
ρυθμίσεις που τα αφορούν. Μέσω αυτών των ρυθμίσεων αυτών, μπορούμε να δημιουργήσουμε 
Selections συγκεκριμένου μεγέθους, να κάνουμε feather και να προσθαφαιρέσουμε σε αυτή.

Συντομεύσεις που μας διευκολύνουν για τις επιλογές Add to Selection, Subtract from Selection και 
Intersect with Selection είναι οι ακόλουθες:

Shift: Κρατώντας πατημένο το πλήκτρο Shift μπορούμε να κάνουμε επιπλέον προσθήκες σε ένα 
Selections
Alt/ Option: Κρατώντας πατημένο το πλήκτρο Alt (για Pc) ή το πλήκτρο Option (για Mac) 
μπορούμε να αφαιρέσουμε τμήματα ενός Selection.
Shift+Alt/Option: Κρατώντας πατημένα τα πλήκτρα Shift+Alt (για Pc) ή Shift+Option (για Mac) 
μπορούμε να δημιουργήσουμε ένα Selection που θα είναι αποτέλεσμα της διασταύρωσης δυο 
άλλων.  

Τι είναι η τιμή feather:
Εισάγοντας μια τιμή στο πεδίο feather θα εφαρμοστεί ένα “Feather effect” στο 
Selection μας. Το εφέ αυτό θα κάνει πιο ομαλές (soften) ή θα αναμείξει (blend) τις 
άκρες του Selection που δημιουργήσαμε. Να τονίσω ότι για να εφαρμοστεί το 
feathering πρεπει να εισάγουμε μια τιμή στο αντίστοιχο πεδίο ΠΡΙΝ δημιουργήσουμε 
οποιοδήποτε Selection. 

Πως θα δημιουργήσουμε ένα Selection που θα έχει Fixed Ratio ή συγκεκριμένες διαστάσεις.

• Επιλέγουμε το Layer στο οποίο θα εφαρμόσουμε το Selection.

• Επιλέγουμε το Rectangle Marquee tool ή το Elliptical Marquee tool.

Για Fixed Ratio

Από το πεδίο επιλογής Style της Options bar επιλέγουμε Fixed Ratio και εισάγουμε τις τιμές που 
επιθυμούμε για Width και Height για την αναλογία του Selection.

Στην συνέχεια, απλά σύρουμε διαγώνια για να δημιουργήσουμε το Selection.



Για Fixed Size

Από το πεδίο επιλογής Style της Options bar επιλέγουμε Fixed Size και εισάγουμε τις τιμές που 
επιθυμούμε για Width και Height του Selection.

Έπειτα, απλά κάνουμε κλικ πάνω στον καμβά μας.

Προσοχή:
Οι επιλογές που θέτουμε μέσω της Option bar δεν επαναφέρονται στις προεπιλεγμένες τους 
ρυθμίσεις την επόμενη φορά που θα  χρησιμοποιήσουμε το ίδιο εργαλείο. Θυμηθείτε λοιπόν ότι 
κάθε φορά που έχουμε αλλάξει κάποια από τις επιλογές τις Option bar για ένα από τα Marquee 
εργαλεία, αυτή θα είναι η ρύθμιση που θα έχει παραμείνει ως προεπιλογή. 

Για να αποφύγουμε λοιπόν τυχόν ατυχήματα, προτείνουμε την χειροκίνητη επαναφορά των 
ρυθμίσεων, όταν φυσικά έχουμε τελειώσει με την χρήση του αντίστοιχου εργαλείου.

Πότε να χρησιμοποιούμε τα Marquee tools

Τα Marquee tools είναι από τα πιο εύχρηστα και ταυτόχρονα βασικά εργαλεία του Photoshop. Παρ' 
όλα αυτά μπορούν να χρησιμοποιηθούν κυρίως για απλά Selections. Για πιο σύνθετα Selections, 
κυρίως ως προς το σχήμα τους, μπορούμε να χρησιμοποιούμε κάποια από τις μεθόδους που θα 
αναφέρουμε στην συνέχεια.  

2.5 Lasso tools

Τα Lasso tool αποτελούνται από το εξής σύνολο εργαλείων επιλογής: Lasso tool, Polygonal Lasso 
tool και Magnetic Lasso tool.

Η συντόμευση για τα εργαλεία αυτά είναι το πλήκτρο L. 

Ελάχιστα πιο πολύπλοκα από τα Marquee, τα Lasso tools μας δίνουν μεγαλύτερη ελευθερία ως 
προς το σχήμα του Selection.

Lasso tools



2.5.1 Lasso Tool  

Το Lasso tool μας παρέχει έναν γρήγορο τρόπο επιλογής μια περιοχής, όμως χωρίς να έχουμε την 
δυνατότητα να τον επιλέξουμε με την μέγιστη ακρίβεια. Για να χρησιμοποιήσουμε το συγκεκριμένο 
εργαλείο απλά κάνουμε παρατεταμένο κλικ στον καμβά μας και ταυτόχρονα σχεδιάζουμε με το 
ποντίκι στο σχήμα που επιθυμούμε. Όταν απελευθερώσουμε το κλικ, το Selection θα ολοκληρωθεί 
αυτόματα.

2.5.2 Polygonal Lasso Tool  

Χρησιμοποιώντας αυτό το εργαλείο μπορούμε να δημιουργήσουμε ένα Selection που αποτελείται 
από ευθείες γραμμές. 

Για να χρησιμοποιήσουμε το Polygonal Lasso tool απλά κάνουμε κλικ στον καμβά μας και στην 
συνέχεια συνεχίσουμε να κάνουμε κλικ μέχρι να περιστοιχίσουμε την περιοχή που θέλουμε. 

Με το εργαλείο αυτό δεν κάνουμε Click + Drag (σύρουμε). Για να ολοκληρώσουμε ένα selection 
πρέπει να κάνουμε ξανά κλικ στο πρώτο σημείο της επιλογής. Εναλλακτικά, μπορούμε να κάνουμε 
διπλό κλικ οπουδήποτε στον καμβά μας για να σχεδιαστεί αυτόματα ένα ευθύγραμμο τμήμα που θα 
εκτείνεται από το τελευταίο και ως το αρχικό σημείο που εισάγαμε, πράγμα που θα ολοκληρώσει 
το Selection.



2.5.3 Magnetic Lasso Tool  

Το Magnetic Lasso tool διαφέρει από τα υπόλοιπα Lasso tools λόγω του ότι κάνει tracing 
(περιγράφει) την περιοχή που επιθυμούμε.

Σημείωση:
Ενδεικτικά αναφέρουμε ότι σε πολύ σύνθετες εικόνες το αποτέλεσμα μπορεί να μην έχει μεγάλη 
ακρίβεια. Για τον λόγο αυτό μπορεί να γίνει συνδυασμό χρήσης αυτού του εργαλείου και του Quick 
selection tool. 

Για την χρήση του Magnetic Lasso, κάνουμε κλικ πάνω στην εικόνα μας και αργά, κινούμε το 
ποντίκι γύρω από το αντικείμενο που επιθυμούμε να κάνουμε το Selection. Θα παρατηρήσουμε ότι 
μια γραμμή αποτελούμενη από σημεία στερέωσης αλλιώς γνωστά ως fastening points είτε anchor 
points, θα αρχίζει να περιστοιχίζει την περιοχή που επιθυμούμε (δείτε την παραπάνω εικόνα). Τα σημεία 
μπαίνουν αυτόματα, όμως μπορούμε να τα εισάγουμε και εμείς χειροκίνητα στην θέση που 
επιθυμούμε, κάνοντας απλά κλικ. 
Για να ολοκληρώσουμε το Selection είτε κάνουμε κλικ στο αρχικό σημείο που έχουμε εισάγει είτε 
κάνουμε διπλό κλικ στον καμβά μας, πράγμα που θα ολοκληρώσει αυτόματα το Selection.
Το εργαλείο αυτό έχει επιμέρους διαθέσιμες ρυθμίσεις μέσω της Option bar οι οποίες μας δίνουν 
την δυνατότητα να αλλάξουμε τις τιμές Width, Contrast και Frequency. 



Η τιμή Frequency καθορίζει τον ρυθμό με τον οποίο τα fastening points θα εφαρμόζονται στην 
επιλογή μας. Όσο μεγαλύτερος είναι αυτός ο αριθμός, τόσο περισσότερα σημεία θα προστίθενται.
Βέβαια, καλύτερη λύση αποτελεί η χειροκίνητη εισαγωγή σημείων σε τμήματα που δεν έχουν 
εισαχθεί fastening points αυτόματα παρά η αύξηση της τιμής frequency. 

Σημείωση:
Ας πούμε ότι θέλουμε να επιλέξουμε ένα αντικείμενο μέσα από μια φωτογραφία. Όσο πιο πολλά 
χρώματα έχει η φωτογραφία και όσο πιο πολύπλοκο είναι το background της, τόσο πιο δύσκολο θα 
είναι για το Magnetic Lasso tool να κάνει σωστά το tracing. Λόγω του ότι η διαδικασία του Selection 
με το Magnetic Lasso είναι ήμι-αυτοματοποιημένη δεν ενδείκνυται για εικόνες μεγάλης χρωματικής 
πολυπλοκότητας.

Πότε χρησιμοποιούμε τα Lasso tools

Τα Lasso tools είναι ικανά να δημιουργήσουν ένα αρκετά πολύπλοκο Selection με μέτριου βαθμού 
ευκρίνεια στην πλειοψηφία των περιπτώσεων.

Μπορούμε βέβαια, να χρησιμοποιήσουμε ανεπιφύλακτα το Polygonal Lasso για επιλογή τμημάτων 
με γωνίες.  Τα υπόλοιπα Lasso tool τα χρησιμοποιούμε κρίνοντας από το πόσο πολύπλοκη είναι η 
περιοχή που θέλουμε να επιλέξουμε και από το ποσοστό ακριβείας που επιθυμούμε να έχει το 
Selection που θα δημιουργήσουμε. 

2.6 Magic Wand  

Το εργαλείο αυτό είναι ένα από τα πιο γνωστά εργαλεία του προγράμματος και ο τρόπος 
λειτουργίας του είναι πολύ απλός. Κάνοντας κλικ σε μια εικόνα, το Magic Wand tool επιλέγει 
περιοχές με παρόμοιο χρώμα του σημείου που επιλέξαμε. 

Έχοντας επιλέξει το εργαλείο, μπορούμε να δούμε τις επιμέρους ρυθμίσεις που γίνονται διαθέσιμες 
σε εμάς μέσω της Options bar. 

Tolerance

Η τιμή Tolerance καθορίζει το εύρος των χρωμάτων που θα επιλεγούν. Δηλαδή επιλέγοντας μια 
τιμή 10 για την επιλογή Tolerance, θα προκαλέσουμε την επιλογή 10 πιο σκούρων και 10 
ελαφρύτερων επιπέδων φωτεινότητας από αυτό που έχουμε ήδη επιλέξει. Αντίστοιχα μια υψηλή 
τιμή Tolerance θα έχει σαν αποτέλεσμα την επιλογή ακόμη μεγαλύτερου εύρους χρωμάτων. 

Contiguous

Από προεπιλογή, το Magic Wand tool δημιουργεί ένα Selection μεταξύ παρόμοιων pixels τα οποία 
όμως συνδέονται μεταξύ τους. Δηλαδή, θα δούμε ότι πρακτικά μόνο μια περιοχή θα επιλεγεί. 
Απενεργοποιώντας την ρύθμιση “Contiguous” ουσιαστικά αναγκάζουμε το Wand να αγνοήσει την 
σύνδεση αυτή και αντ' αυτού να επιλέξει κάθε pixel της επιφάνειας εργασίας που είναι σε κοντινά 
χρωματικά επίπεδα με το σημείο που έχουμε κάνει κλικ δημιουργώντας έτσι πολλαπλά Selections.

Μια επιλογή του Magic Wand χωρίς την παρουσία της ρύθμισης Contiguous, μοιάζει πολύ με μια 
Color Range Selection όπως θα δούμε στην συνέχεια.

Sample All Layers
Η επιλογή αυτή μας δίνει την δυνατότητα επιλογής του αν το Magic Wand θα λάβει υπόψιν του όλα 



τα υπάρχοντα Layers ή μόνο το τρέχον επιλεγμένο.  

Πότε χρησιμοποιούμε το Magic Wand Tool

Το Magic Wand tool είναι ένα εργαλείο που ενδείκνυται για απλές αλλά πολύ γρήγορες επιλογές 
που δεν χρειάζονται μεγάλη ακρίβεια.

 Τιμή Tolerance 10                                           Τιμή Tolerance 100

2.7 Quick selection tool  

Νέο εργαλείο, το οποίο εισήχθηκε στο πρόγραμμα από την έκδοση CS3 και έπειτα, είναι ένα από 
τα πιο χρήσιμα και πρακτικά Selection tools που υπάρχουν. Μπορεί θεωρητικά να μοιάζει με το 
Magic Wand όμως μια βασική τους διαφορά είναι ότι το Quick Selection tool δημιουργεί 
Selections, λαμβάνοντας επιπλέον υπόψιν του τον τόνο και το χρώμα. Επίσης μπορεί να εντοπίσει 
πανομοιότυπα textures σε μια εικόνα, πράγμα που το κάνει εξαιρετικά πρακτικό στον εντοπισμό 
¨ακρών¨ (edges) σε εικόνες. 

Για να γίνουμε πιο συγκεκριμένοι μπορούμε να πούμε το εξής για το εργαλείο αυτό: Λειτουργεί 
σαν Βrush. Μπορούμε δηλαδή να επιλέξουμε brush size, hardness και spacing και στην συνέχεια 
απλά να ¨βάψουμε¨ πάνω από την επιλογή που θέλουμε να γίνει το Selection.

Πότε χρησιμοποιούμε το Quick Selection Tool

Μπορούμε σύμφωνα με την κρίση μας αλλά και το Selection που θέλουμε να δημιουργήσουμε να 
χρησιμοποιήσουμε το εργαλείο αυτό σε πληθώρα περιπτώσεων. Είναι γρήγορο, πρακτικό και 
ταυτόχρονα έχει πολύ ικανοποιητικό ποσοστό ως προς την λεπτομέρεια του Selection (έχοντας 



πάντα τις σωστές ρυθμίσεις που το αφορούν στην Options bar).

Συνιστούμε να προτιμάτε σχεδόν πάντοτε την χρήση του από το Magic Wand μιας και τις 
περισσότερες φορές το αποτέλεσμα του Selection, συγκριτικά πάντα,  είναι πολύ καλύτερο.

2.8 Color Range

Όπως αναφέραμε και στην περιγραφή του Magic Wand tool, η εντολή Color Range μοιάζει με μια 
non-contiguous Magic Wand Selection. Μας δίνει την δυνατότητα να επιλέξουμε με ταχύτητα όχι 
απλά ένα χρώμα αλλά ένα χρωματικό εύρος της επιφάνειας εργασίας μας.

Την εντολή Color Range την εντοπίζουμε ανατρέχοντας στο κεντρικό μενού και επιλέγοντας
Select > Color Range

Επιλέγοντας την εντολή θα εμφανιστεί στην οθόνη μας το παράθυρο διαλόγου της επιλογής. Ο 
κέρσορας τώρα θα αλλάξει σε ένα eyedropper εικονίδιο με το οποίο μπορούμε να επιλέξουμε 
σημεία πάνω στην επιφάνεια εργασία μας.

Fuzziness

Με το slider της επιλογή Fuzziness μπορούμε να ρυθμίσουμε το πόσο ακριβής είναι η αντιστοίχιση 
του χρώματος.

Κάτω από τα sliders μπορούμε να δούμε μια ασπρόμαυρη επισκόπηση οπού τα λευκά τμήματα  
αντιπροσωπεύουν τα τμήματα της εικόνας που έχουν επιλεγεί ενώ τα μαύρα, τα τμήματα της 
εικόνας που δεν έχουν επιλεγεί.

Στην παραπάνω εικόνα έχει επιλεγεί το μπλε χρώμα της κούπας.

Για να προσθέσουμε τμήματα στην υπάρχουσα επιλογή μας (add to selection) μπορούμε να 
κρατήσουμε πατημένο το πλήκτρο Shift και να κάνουμε κλικ ενώ αντίστοιχα,για αφαιρέσουμε 
(subtract from selection) κρατάμε πατημένο το πλήκτρο Alt/Option. Βέβαια, μπορούμε για τις ίδιες 
λειτουργίες να χρησιμοποιήσουμε τα αντίστοιχα εικονίδια που είναι διαθέσιμα στο δεξί τμήμα του 
παραθύρου διαλόγου Color Range.



Πότε χρησιμοποιούμε την εντολή Color Range

Η εντολή Color Range αν και πολύ αποτελεσματική δεν έχει μεγάλο εύρος χρήσης. Εμπειρικά θα 
δείτε ότι για να μπορέσει να αξιοποιηθεί σωστά πρέπει η εικόνα μας να έχει πολύ ξεκάθαρα 
χρωματικά τμήματα. Στην εικόνα του παραδείγματος μπορούμε να πούμε ότι το Color Range 
λειτουργεί με σχετική ακρίβεια λόγω του ότι τα μπλε τμήματα δεν απέχουν τονικά, πολύ μεταξύ 
τους. 

Πρακτικά όμως οι σκιές που υπάρχουν στις περισσότερες εικόνες δημιουργούν μεγάλες τονικές 
διαβαθμίσεις, πράγμα που καθιστά δύσκολή την σωστή επιλογή. Συμπερασματικά, μπορούμε να 
καταλάβουμε ότι η αποτελεσματικότητα του αρχείου αυτού εξαρτάται σε μεγάλο βαθμό από την 
εικόνα της οποίας τα τμήματα θέλουμε να επιλέξουμε.

2.9 Pen Tool  

Το Pen Tool είναι ένα από τα πιο διαδεδομένα εργαλεία του Photoshop και ένα από τα πλέον 
κατάλληλα για τη δημιουργία ενός πολύπλοκου Selection με μεγάλη ακρίβεια. 

Για να δημιουργήσουμε ένα Selection με το Pen tool επιλέγουμε αρχικά το εργαλείο και στην 
συνέχεια, με την δημιουργία κόμβων (anchor points), μπορούμε να περιγράψουμε, ή όπως λέγεται 
να κάνουμε tracing, την περιοχή που επιθυμούμε. 

Για μεγαλύτερη ευκολία, όταν αποφασίσουμε να χρησιμοποιήσουμε το Pen tool για την δημιουργία 
κάποιου Selections και όχι για την κατασκευή κάποιου διανυσματικού σχήματος, είναι προτιμότερο  
να χρησιμοποιούμε την επιλογή Path που αφορά το συγκεκριμένο εργαλείο και μπορούμε να την 
εντοπίσουμε στην Option bar (έχοντας φυσικά πρώτα επιλέξει το Pen tool).  

Με τον τρόπο αυτό θα μπορέσουμε να περιστοιχίσουμε το τμήμα που επιθυμούμε έχοντας μόνο ένα 
ίχνος ως περίγραμμα (Path). 

Επιλογή Paths από την Options bar

Πως θα μετατρέψουμε το Path σε Selection

Για να γίνουμε όμως πιο συγκεκριμένοι, το εργαλείο αυτό είναι πρωταρχικά σχεδιασμένο για την 
δημιουργία Paths που όμως μπορούν να γίνουν πολύ εύκολα Selection χρησιμοποιώντας την 
συντόμευση Ctrl/Command + Enter. 
Εναλλακτικά μπορούμε κάνουμε δεξί κλικ πάνω και επιλέγουμε την επιλογή Make selection. Τώρα 
στην οθόνη μας θα εμφανιστεί το δεξί παράθυρο του παρακάτω παραδείγματος.



Παρατηρούμε ότι υπάρχει επιλογή η οποία ρυθμίζει την ποσότητα του feather. Όσο μεγαλύτερη 
είναι η τιμή, τόσο πιο ¨σκληρές¨ (sharp edges) είναι οι άκρες ενώ αντίθετα, όσο πιο μεγάλη είναι η 
τιμή τόσο πιο ομαλές είναι οι άκρες (smooth edges). 

Το πλήθος των δυνατοτήτων του Pen Tool καθιστούν την χρήση του πολυπλοκότερη αυτής των 
υπολοίπων εργαλείων. Για τον λόγο αυτό θα αφιερώσουμε μεγάλο μέρος της επόμενης ενότητας 
στην αναλυτική κατανόηση και επεξήγηση του.

Ενδεικτικά όμως, και για την καλύτερη κατανόηση του εργαλείου στην παρούσα ενότητα, 
μπορούμε να αναφέρουμε ότι το δυνατό σημείο του Pen Tool είναι η δημιουργία καμπύλων 
τμημάτων με μεγάλη ακρίβεια, πράγμα που το καθιστά το εργαλείο ιδανικό για σύνθετα Selections. 
Αποκτώντας λοιπόν ευχέρεια στην χρήση του εργαλείου, θα δούμε ότι μπορούμε να το 
χρησιμοποιήσουμε για ένα μεγάλο εύρος λειτουργιών. 

Γιατί όμως να μην χρησιμοποιήσουμε το Quick Selection Tool;

Καταρχήν γιατί μπορούμε να είμαστε πολύ πιο ακριβείς και συγκεκριμένοι δημιουργώντας ένα 
Selection με το Pen tool. 
Ένας επιπλέον λόγος, που είναι πολύ σημαντικός είναι το ότι τα paths που δημιουργούμε με το 
εργαλείο αυτό είναι Vector (διανυσματικά) πράγμα που τα καθιστά εξαιρετικά ευέλικτα, αφήνοντάς 
μας να τα επεξεργαστούμε περαιτέρω οποιαδήποτε στιγμή το επιθυμούμε. Τέλος, να αναφέρουμε 
ότι τα Paths μπορούν να αποθηκευθούν σε πολλούς τύπους αρχείων, δίνοντας έτσι μια πολύ απλή 
λύση στην πιθανή ανάγκη του να συμπεριληφθεί ένα Selection μέσα σε ένα αρχείο που δεν 
υποστηρίζει Layers. 

Πότε χρησιμοποιούμε το Pen tool 

Εμπειρικά θα δείτε ότι το Pen tool είναι το εργαλείο που μπορεί να αντεπεξέλθει και στα πιο 
απαιτητικά Selections. Όταν λοιπόν επιθυμούμε να επιλέξουμε ένα τμήμα μιας εικόνας που, λόγο 
της πολυπλοκότητας της, δεν ενδείκνυται να χρησιμοποιήσουμε κάποια από τις υπόλοιπες 
μεθόδους επιλογής τότε συνίσταται η χρήση του Pen tool. Τέλος ενδείκνυται η χρήση του αν 
επιθυμούμε την δημιουργία ενός διανυσματικού (Vector) Path του Selection που μόλις 
δημιουργήσαμε. Δεν συνίσταται για Selections με soft edges.



2.10 Quick Masks

Η δημιουργία ενός Selection με την χρήση Quick mask μπορεί να αποβεί πολύ πρακτική λόγο του 
ότι μπορούμε να ελέγξουμε σε μεγάλο βαθμό το τι επιθυμούμε να επιλέξουμε. Η συντόμευση για 
την ενεργοποίηση του Quick Mask mode είναι το πλήκτρο Q.

Εναλλακτικά μπορούμε να κάνουμε κλικ στο αντίστοιχο εικονίδιο του Tools panel όπως φαίνεται 
και στην παρακάτω εικόνα.

Εικονίδιο του Quick Mask Mode

Όταν ενεργοποιήσουμε την επιλογή αυτή η παλέτα των χρωμάτων μας πρέπει να αλλάξει αυτόματα 
και ως Foreground να τεθεί το μαύρο χρώμα ενώ ως Background το λευκό.

Σημείωση:
Αν τα χρώματα που ήταν επιλεγμένα πριν την είσοδο σε Quick Mask mode ήταν τα προεπιλεγμένα 
(μαύρο, λευκό) δεν θα δούμε αλλαγές στα τετράγωνα εικονίδια τους αλλά θα παρατηρήσουμε να 
αλλάζουν τα slider που βρίσκονται δίπλα τους.

Στην εικόνα που φαίνεται παρακάτω μπορούμε να δούμε πως είναι η παλέτα με τα χρώματα μας 
στην προεπιλεγμένη τους μορφή και έπειτα, πως είναι σε Quick Mask Mode.

                 Ανενεργό Quick Mask Mode                                     Ενεργό Quick Mask Mode

Σε αυτό το σημείο θα χρειαστούμε το Brush tool για να συνεχίσουμε και να μπορέσουμε να 
δημιουργήσουμε την περιοχή του Selection. 

Χρησιμοποιούμε το μαύρο χρώμα για τις περιοχές που θέλουμε να προστεθούν στο Selection ενώ 



το λευκό χρώμα για τις περιοχές που θέλουμε να αφαιρεθούν. 
Άρα αφού επιλέξουμε το Brush tool μπορούμε να ξεκινήσουμε να ¨βάφουμε¨ πάνω από την περιοχή 
που επιθυμούμε. Θα παρατηρήσουμε τώρα, ότι στην επιφάνεια εργασίας, η περιοχή την οποία 
βάψαμε με μαύρο χρώμα καλύπτεται με μια κόκκινη ημιδιαφανής απόχρωση. 

Για να βγούμε από το Quick Mask Mode μπορούμε είτε να πατήσουμε το πλήκτρο Q είτε να 
ξαναπατήσουμε το εικονίδιο του Tools Panel.

Θα δούμε διακεκομμένες γραμμές να περιβάλλουν το Selection που δημιουργήσαμε.

Να τονίσουμε εδώ, ότι από προεπιλογή στο Photoshop, η περιοχή η οποία είναι καλυμμένη με το 
κόκκινο χρώμα είναι η περιοχή που έχει γίνει Masked. Δηλαδή το Selection μας θα αποτελείται από 
όλη την υπόλοιπη περιοχή ΕΚΤΟΣ αυτής που ¨βάψαμε¨.

Μπορούμε να εφαρμόσουμε πλήθος ρυθμίσεων στο Brush tool που αφορούν μεταξύ άλλων το 
σχήμα και το μέγεθος του ίχνους που αφήνει μέσω της Options bar. Αναλυτικά θα γνωρίσουμε το 
Brush tool σε επόμενη ενότητα. 

Για να αντιστρέψουμε το Selection μπορούμε να επιλέξουμε από το κεντρικό μενού την επιλογή 
Select > Inverse

Εναλλακτικά, μπορούμε να κάνουμε κλικ στο εικονίδιο του Quick Mask Mode για να εμφανίσουμε 
το παράθυρο διαλόγου Quick Mask Option.  

Από εκεί, μπορούμε να καθορίσουμε χειροκίνητα, ποια περιοχή αντιπροσωπεύει το κόκκινο χρώμα 
και ποια όχι. 

Πότε χρησιμοποιούμε το Quick mask Mode 

Το Quick Mask mode μπορούμε να το χρησιμοποιήσουμε, όταν θέλουμε να δημιουργήσουμε 
Selections σχετικής ακρίβειας, γρήγορα. 



2.11 Layer Mask

Η χρήση μιας Layer Mask είναι μια πολύ χρήσιμη, μη καταστροφική μέθοδος επεξεργασίας. 
Μας δίνει την δυνατότητα να επιστρέψουμε και να επεξεργαστούμε ξανά το Selection που αρχικά 
έχουμε δημιουργήσει οποιαδήποτε στιγμή το επιθυμούμε. 
Επίσης, με την μέθοδο αυτή μπορούμε να αποκρύψουμε τελείως τμήματα μιας εικόνας, χωρίς στην 
ουσία να τα διαγράψουμε. Αυτό το στοιχείο είναι αυτό που καθιστά την χρήση των Layer Masks 
μη-καταστροφική μέθοδο.

Για να δημιουργήσουμε μια Layer Mask:

Για να δημιουργήσουμε μια Layer Mask  κάνουμε το Selection που επιθυμούμε με όποιο από τα 
εργαλεία κρίνουμε ότι είναι κατάλληλο και στην συνέχεια κάνουμε κλικ στο εικονίδιο ¨Add Layer 
Mask¨ που βρίσκεται στο κάτω τμήμα του Layers Panel.

 

Τώρα, η περιοχή που επιλέξαμε έχει μετατραπεί σε μια Layer mask. Στο Layers panel μπορούμε να 
δούμε ότι ένα νέο εικονίδιο επισκόπησης έχει προστεθεί και είμαι συνδεδεμένο (linked) με το Layer 
στο οποίο εφαρμόστηκε η μάσκα.

Προεπισκόπηση μιας Layer Mask συνδεδεμένης με το original Layer

Να τονίζω ότι στην οθόνη έχει παραμείνει τώρα το τμήμα το οποίο είχαμε περιγράψει με το 
εργαλείο επιλογής. 

Για να επεξεργαστούμε περαιτέρω την μάσκα, που σε αυτή την περίπτωση είναι και το τμήμα της 
εικόνας που έχουμε επιλέξει, κάνουμε κλικ πάνω στο Thumbnail (προεπισκόπηση) της μάσκας.

Στην συνέχεια, χρησιμοποιώντας το Brush tool  μπορούμε να ¨βάψουμε¨ είτε με λευκό είτε με 
μαύρο χρώμα, αναλόγως των περιοχών που θέλουμε να εμφανίσουμε ή να αποκρύψουμε.

Βάφοντας με μαύρο χρώμα θα αποκρύψουμε Pixels, ενώ βάφοντας με λευκό θα εμφανίσουμε τα 



Pixels του αυθεντικού Layer.

Να τονίσω ότι εκτός από το λευκό και μαύρο χρώμα που χρησιμοποιούμε για την εμφάνιση και 
αντίστοιχα απόκρυψη των τμημάτων μιας εικόνας, μπορούμε να χρησιμοποιήσουμε και ενδιάμεσες 
αποχρώσεις του γκρι οι οποίες θα δημιουργήσουν ένα αποτέλεσμα ήμι-διαφάνιας.   

Πότε χρησιμοποιούμε μια Layer Mask

Χρησιμοποιούμε μια Layer mask όταν επιθυμούμε μεγάλη ακρίβεια σε ένα Selection που δεν είναι 
απαραίτητη η χρήση Vector path.

Ακόμη πιο σημαντικό είναι το γεγονός ότι κάνοντας χρήση μιας Layers mask έχουμε την 
δυνατότητα δημιουργίας ενός Selection το οποία μπορούμε διαρκώς να εξελίσσουμε 
χρησιμοποιώντας τόσο soft όσο και hard edges.

2.12 Channels

Η δημιουργία αληθινά σύνθετων Selections και μασκών, αποτελεί μια χρονοβόρα διαδικασία που 
μπορεί να τελειοποιηθεί μόνο με το πέρασμα του χρόνου και φυσικά μέσα από την εξάσκηση. Η 
τελευταία μέθοδος που θα αναφέρουμε στην ενότητα αυτή είναι μια από τις πιο σύνθετες αλλά 
αποτελεί μια από τις πλέον κατάλληλες για ορισμένες περιπτώσεις. 

Για να δημιουργήσουμε μια Selection με την βοήθεια των Channels καταρχήν πρέπει να 
ανατρέψουμε στο Channels Panel. Μπορούμε να δούμε την καρτέλα του δίπλα στο Layers panel. 
Κάνοντας κλικ στην καρτέλα αυτή, τα περιεχόμενα των Channels θα αντικαταστήσουν αυτά των 
Layers.

Επιθεωρώντας τα Channel πρέπει να έχουμε στο μυαλό μας ότι το λευκό χρώμα ισοδυναμεί με 
πλήρη επιλογή, το μαύρο με καθόλου επιλογή και οι μεταξύ τους αποχρώσεις με ενδιάμεσα επίπεδα 
Selection. Μπορεί να μοιάζει μπερδεμένη σαν σκέψη όμως θα εξηγήσουμε στην συνέχεια την 
λογική της προαναφερόμενης φράσης.

Τώρα βάση του παραπάνω, επιλέγουμε το Channel το οποίο εξυπηρετεί περισσότερο στην επιλογή 
που επιθυμούμε να δημιουργήσουμε. Θα χρησιμοποιήσουμε στην συνέχεια το Channel αυτό προς 
όφελος μας.

Παρατηρούμε την παρακάτω εικόνα.

Ας πούμε λοιπόν, ότι θέλουμε ένα πολύ λεπτομερές Selection του τριχώματος της παραπάνω 



εικόνας έτσι ώστε να μπορέσουμε να αφαιρέσουμε το λευκό φόντο. Όπως ήδη θα έχετε καταλάβει, 
αυτό είναι κάτι το οποίο δεν μπορεί να επιτευχθεί εύκολα χρησιμοποιώντας κάποια από τις 
προηγούμενες μεθόδους λόγο της μεγάλης λεπτομέρειας του τριχώματος.

Ενώ λοιπόν βρισκόμαστε στο Panel των Channel προσπαθούμε να εντοπίσουμε το κανάλι που έχει 
το μεγαλύτερο contrast και στην συνέχεια το διπλασιάζουμε. Στην συνέχεια συνδυάζοντας τις 
γνώσεις μας από τις προηγούμενες μεθόδους και εφαρμόζοντας μια σειρά κινήσεων που αφορούν 
αλλαγές μέσω των Level Adjustments, dodge & burn tools κ.α μπορούμε να αυξήσουμε ακόμη 
περισσότερο το Contrast και εν τέλη να επιτύχουμε το Selection. 

Λόγο της πολυπλοκότητας της συγκεκριμένης μεθόδου, θα αναφερθούμε ξανά στην πέμπτη 
ενότητα όπου με την βοήθεια μιας άσκησης θα κατανοήσουμε πλήρως την λειτουργία των 
Channels.

Στο σημείο αυτό έχουμε ολοκληρώσει το θεωρητικό κομμάτι της ενότητας αυτής και μέσα από τις 
ασκήσεις που ακολουθούν θα δείξουμε πρακτικά και βήμα προς βήμα, τον τρόπο με τον οποίο 
μπορούμε να επιτύχουμε ένα Selection.

2.13 Πρακτική εξάσκηση

Άσκηση 1η
Πώς να αφαιρέσουμε το φόντο από αντικείμενα απλού σχήματος.

Σε αντικείμενα που έχουν απλές φόρμες είναι πολύ εύκολο να αφαιρέσουμε το background τους. Ας 
υποθέσουμε λοιπόν, ότι θέλουμε να εξάγουμε το παρακάτω μπαλάκι του τένις από το φόντο του.

Καταρχήν ανοίγουμε την εικόνα μας στο Photoshop. 



Σημείωση:
Όταν ανοίγουμε μια εικόνα στο Photoshop, αυτή η εικόνα είναι από προεπιλογή, κλειδωμένη. Για να 
την ξεκλειδώσουμε κάνουμε διπλό κλικ στο Layer της εικόνας (Background Layer)που βρίσκεται 
στο Layers panel και πατάμε ΟΚ στο παράθυρο που θα εμφανιστεί.

Επιλέγουμε το Elliptical Marquee Tool από την tool bar μας στο αριστερό μέρος της οθόνης.
Εφόσον το σχήμα του αντικειμένου που θέλουμε να εξάγουμε είναι κύκλος, θα κάνουμε ένα 
κυκλικό Selection (επιλογή). 
Για να εντοπίσουμε καλύτερα το κέντρο του αντικειμένου επιλέγουμε 
 View > Show > Grid

Σημείωση:
Δεν είναι απαραίτητο να βρούμε ακριβώς το κέντρο του αντικειμένου μας. Εφόσον έχουμε κάνει την 
κυκλική μας επιλογή μπορούμε να την μετακινήσουμε χρησιμοποιώντας τα βελάκια.

Τώρα που μας είναι πιο εύκολο να εντοπίσουμε το κέντρο του αντικειμένου, επιλέγουμε το 
Elliptical marquee tool, κρατάμε πατημένα τα πλήκτρα Alt + Shift, κάνουμε αριστερό κλικ στο 
κέντρο της μπάλας και σύρουμε (drag) μέχρι να επιλέξουμε ολόκληρο το αντικείμενο.

Γιατι το πλήκτρο Swift? Όπως έχουμε αναφέρει και στο παρελθόν, το πλήκτρο Shift 
χρησιμοποιείται συχνά στο Photoshop για την δημιουργία τέλειων σχημάτων. Στην περίπτωση 
αυτή, κρατώντας πατημένο το Shift και έχοντας επιλεγμένο το Elliptical Marquee Tool μπορούμε 
να δημιουργήσουμε ένα κύκλο.

Γιατί το πλήκτρο Alt? Πατώντας το πλήκτρο Alt η έναρξη της επιλογής μας συμπίπτει με το κέντρο 
του κύκλου, διαφορετικά (αν δεν κρατήσουμε πατημένο το Alt) η έναρξη της επιλογής μας 
συμπίπτει με ένα σημείο της περιφέρειας του κύκλου.   



Όταν έχουμε επιλέξει το αντικείμενο μας με επιτυχία, αντιστρέφουμε την επιλογή μας 
ανατρέχοντας στην Menu bar και επιλέγοντας
Select > Inverse (ή πατώντας Shift + Ctrl + I) 

Τέλος, πατάμε delete.

Έχουμε πλέον αφαιρέσει το φόντο.

Σημείωση:
Σε περίπτωση που θέλουμε να αποθηκεύσουμε μια εικόνα με διάφανο background που να μην είναι 
αρχείο Photoshop, πρέπει να αποθηκεύσουμε σε format .PNG  

   



Η παραπάνω άσκηση λόγω του ότι background της είναι ενός ομοιογενούς χρώματος μπορεί να 
εκτελεστεί και με πιο εύκολους τρόπους.

Ένας από αυτούς είναι ο παρακάτω: 

Επιλέγοντας το Magic Erase tool απο το Tools panel μας και κάνοντας απλά κλικ πάνω στην λευκή 
περιοχή της εικόνας μας.

Όπως θα παρατηρήσουμε, έχουμε αφαιρέσει το background μας πολύ πιο σύντομα από τον 
προηγούμενο τρόπο.

Θα ήθελα να τονίσω ότι σε περίπτωση που υπάρχουν και άλλα στοιχεία στο φόντο (δηλαδή όχι 
solid color) η χρήση του Magic Wand δεν θα λειτουργήσει.

Σε περίπτωση λοιπόν που έχουμε background με ποικιλία στοιχείων, σωστό θα ήταν να 
χρησιμοποιήσουμε τον πρώτο τρόπο που αναφέραμε και που δεν εξαρτάται από το περιεχόμενο του 
φόντου.

   



Άσκηση 2

Αφαίρεση του background με την βοήθεια του Magnetic lasso tool.  

Το Magnetic lasso tool ανιχνεύει και ¨κολλάει¨ στην άκρη του κάθε αντικειμένου καθώς 
ιχνογραφούμε το περίγραμμά του.

Καταρχήν λοιπόν ανοίγουμε την εικόνα μας.
Η διαδικασία που ακολουθούμε για το άνοιγμα είναι η ίδια με αυτή της προηγούμενης άσκησης.

 

Καθώς σύρουμε τον κέρσορα στην άκρη του αντικειμένου, το Magnetic tool αφήνει στο πέρασμά 
του σημεία στερέωσης (fastening points) για να κλειδώσει ουσιαστικά τις μέχρι τώρα επιλογές μας. 

Σημείωση: 
Σε αυτό το σημείο θα αναφέρουμε ένα πολύ χρήσιμο shortcut που θα μας βοηθήσει στο να 
χρησιμοποιήσουμε το συγκεκριμένο εργαλείο.
Αν απομακρύνουμε άθελα μας τον κέρσορα από την άκρη του αντικειμένου, είναι πολύ πιθανό να 
προστεθεί κάποιο σημείο (point) σε λανθασμένη θέση. Μπορούμε να αφαιρέσουμε τα σημεία αυτά 
που ΔΕΝ θέλουμε, πατώντας το delete καθώς χρησιμοποιούμε το Magnetic tool.

 



Όταν έχουμε επιτυχώς επιλέξει ολόκληρο το αντικείμενο μας, και κρατώντας τον κέρσορα μας 
πάνω από το πρώτο point που είχαμε ρίξει, θα δούμε το εικονίδιο του tool μας να αλλάζει. 
Παρατηρούμε να εμφανίζεται στην κάτω δεξιά γωνία ένας κύκλος. Κάνοντας κλικ μία φορά πάνω 
στο αρχικό μας point, θα ολοκληρώσουμε την επιλογή μας και θα δούμε την τελική επιλογή μας να 
περιστοιχίζει την εικόνα.

Και πάλι λοιπόν,όταν έχουμε επιλέξει το αντικείμενο μας με επιτυχία, αντιστρέφουμε την επιλογή 
μας ανατρέχοντας στην Menu bar και επιλέγοντας

Select > Inverse (ή πατώντας Shift + Ctrl + I) 

Τέλος, πατάμε Delete.

Μερικές φορές το Magnetic lasso tool αποτυγχάνει να επιλέξει επιτυχώς όλα τα στοιχεία του 
αντικειμένου που θέλουμε.
Μπορούμε λοιπόν να επιλέξουμε το Quick selection tool και να προσθέσουμε τις μη επιλεγμένες 
επιλογές απλά σέρνονται πάνω τους τον κέρσορα.
Στην αντίστοιχη περίπτωση, που θέλουμε να αφαιρέσουμε κάποιες περιοχές που έχουν επιλεχθεί 
κατά λάθος, επιλέγουμε το Quick selection tool κρατώντας πατημένο το Alt.



Τώρα πια το αντικείμενο μας είναι έτοιμο.
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